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Copies of the PowerPoint slides for each module can be found at http://www.ntc.blm.gov/krc/viewresource.php?courseID=590 (scroll down to the bottom of the page).
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Boys and Girls Club of Central Wyoming learning about rocks along the North Platte River in the Casper Field Office.

[bookmark: _Toc342487006]Tips for Taking an Online Course 
Benefits to Online Learning
· You have control over the learning environment.
· You have control over the day and time of day you take the class.
· You have control over how long you participate at one sitting.
· You (may) have control over with whom you participate.   
Disadvantages to Online Learning
· You can’t interact with the instructors in real time (but you can contact them, see their contact information in this Guide).
Learning Environment 
· If you’re taking this course with a group of people, then you’re probably in a conference room.
· If you’re taking this course alone, then you’re probably at your desk or in a library or at home. 
· Let others know you are taking a class and are not to be disturbed.  
· Turn off your cell phone and other distractions.  
· Put up a Do Not Disturb sign (although this would be a little odd if you’re in a library or coffee shop).  
· Get comfortable.  
· Make sure you can see the screen and hear the audio.
· Use headphones if you’re in a place where you don’t want to disturb others.  
· Keep side conversations to a minimum if you’re watching with a group of people.  You may not be interested, but the person next to you might be, so shhhhhhh.
· Pick a day and a time of day when you are fresh and alert.    
· If you miss something, stop the video and watch it again.  
· If you need to think about something, stop the video and think about it.  
· If you need to talk about what you heard with someone, stop the video and talk about it.
· That’s the beauty of online learning – you have control!  (see Benefits, above)
Course Materials
· Participant Guide  
· Maps of your Planning Area  
· Final Environmental Impact Statement/Proposed Resource Management Plan and Record of Decision
· Copies of activity-level plans and decisions, and any documents carried forward into your ROD
· 2005 BLM Planning Handbook (H-1601-1).  Click the hyperlink or search the Web for “BLM Planning Handbook” or go to the webpage where you launched this course.  
[bookmark: _Toc342487007]
Course Outline and Objectives 
The purpose of these three modules is to show you how to develop a strategy to implement your land use plan.  The goal of plan implementation strategy is to increase the consistency of plan implementation among BLM offices, track and measure the progress of implementation by connecting workload accomplishments to land use plan decisions, provide stable and attainable targets, and provide BLM field offices, district offices, and state offices with a valuable tool to prioritize and plan its workload.   

Module 2 Outline.   Step 2:  Prioritize the Work
Introduction 
Factors to Consider
Priority and Magnitude
How to do Step 2
Conclusion/Next Steps 

Module 2 Objectives.   Step 2:  Prioritize the Work
Modify the Factors to Consider in Establishing Priorities to fit your planning area. 
Identify the priority and magnitude for each project/task/ management action identified under Step 1.
Populate columns 6 and 7 in the Plan Implementation Strategy Worksheet.
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Megan Stouffer
Branch Chief for Planning and Assessment 
BLM Colorado State Office
mstouffe@blm.gov
303-239-3936

Brad Higdon
Taos RMP Team Lead
BLM Taos Field Office (Farmington District)
bhigdon@blm.gov 
575-751-4725

Joe Meyer
Field Manager
Casper Field Office (High Plains District)
jmeyer@blm.gov 
307-261-7776
Rem Hawes
Field Manager 
Hassayampa Field Office (Phoenix District)
rhawes@blm.gov 
623-580-5530

Cathy Humphrey (Host)
Planning/NEPA Training Coordinator
National Training Center
chumphre@blm.gov
602-906-5536

[bookmark: _Toc342487009]Sample Excel Spreadsheet 
Example for Direct Community Services – Columns 1-5
	1 & 2

Resources and Programs
(Talk to your state P&EC to make any changes)
	3

Projects, Management Actions, Tasks  
(from RMP)
	4

PEs 
	5


Where

	Fire Management
	Wildfire Management
	 
	 
	 

	
	
	 
	 
	  

	
	
	
	
	

	Access
	Land Tenure
	
	
	

	
	
	
	
	

	
	Land Use (ROWs)
	 
	
	 

	
	
	 
	
	 

	
	
	
	
	

	
	Unauthorized Use
	 
	
	 

	
	
	 
	
	 



Example of Columns 6-13:
	6


Priority
	7


Magnitude
	8


FY12
	9


FY13
	10


FY14
	11


FY15
	12


FY16
	13

Cross Reference

	
	
	
	
	
	
	
	

	 
	 
	 
	 
	 
	 
	 
	 

	 
	 
	 
	 
	 
	 
	 
	 

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	



	Blue represents cells that will be filled in for you.

	 Yellow represents cells you will fill out in STEP 1.

	Red represents cells you will fill out in STEP 2.

	Purple represents cells you will fill out in STEP 3.



NOTE:  To see a completed example spreadsheet, click here.  This example was developed based on real BLM projects across several planning areas to provide you with some ideas to complete your own spreadsheet. 

[bookmark: _Toc342487010]Factors to Consider in Establishing Priorities 
Instructions:  After viewing the instructions on the video for this module, review the following factors and modify (add, subtract, or change) them to fit your planning area and local situation.  Type in the specifics for the following factors, such as the Upper Colorado Gorge, the Black Forest Plan, and the ongoing Cross-country KV Line project—anything that will influence your priorities.

Recommended Participants:  Interdisciplinary team, field and/or district manager, partners, facilitator.

Law, Policy or Regulation
· Laws, regulations, statutes, proclamations, Executive Orders, Secretarial Orders.
· Manuals, handbooks, Instructional Memoranda.
· Other land use plans or activity plans. 
· DOI or BLM priorities or commitments (e.g. MOUs, agreements, contracts, grants).
· Other Federal, State, Tribal, or local laws, policies or priorities. 
· Case law, Court/Congressional/Administrative Mandates, settlement agreements.

Resource Protection or Use
· Geographically important areas (e.g. biologically important areas, high activity areas).
· Projects that meet important FO/RMP objectives for resource protection or commodity production.
· Potential special status species listings from US Fish & Wildlife Service or National Marine Fisheries Service.

Risks
· Health & safety
· Loss of investments/assets, resources, opportunities
· Increased possibility of conflicts ( among programs, internal/external users) 

Workload Factors
· Projects already underway 
· Current funding sources for projects (i.e. base, flexible, contributions; e.g. ARRA projects)
· Sequencing & timing (later in sequence = lower priority or if sequencing with another project makes sense resource, time or funding-wise)

Working Smarter Not Harder / Efficiencies 
· Probability of success (technical; skills; management systems; readiness)
· Cost effectiveness 
· Multiple program/resource benefits, educational/promotional values
· Return on investment
· Partners’ interests and capabilities to contribute.
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Instructions:  Determining the priority of a project, task, or management activity can be tricky; it depends on the factors on the previous page as well as its relationship to other activities.  Consider the balance of tasks under each priority—you don’t want the majority of projects to end up being high priority.  Prioritizing the work in your RMP can be done several ways, watch the video for suggestions.  
Suggested Participants:  Interdisciplinary team (small groups), field and/or district manager, partners, facilitator.

Non-Discretionary:  
· Projects, tasks, or activities that must be done or funded, as mandated by law, policy, health and safety, lawsuit, etc. 
· “Must Do’s”  
· Examples:  Respond to court orders, administer existing permits (rights-of-way, special use permits, etc.)
 
High Priority: 
· Projects, tasks, or activities that should be completed within the next 3-5 years in order to achieve RMP success.  
· Essential activities that relate to key planning issues, important geographical areas, and/or areas of high public interest/concern.  
·  “Should Do’s”
· Examples:  Inventory and map invasive non-native species.

Medium Priority:  
· Projects, tasks, or activities that are not ripe within the short term (3-5 years), 
· Resource damage is not imminent in the short term.
· Resource risks or benefits are less than those identified for high priority projects.
· Cost is greater for anticipated benefit compared to high priority projects.
· Benefits are speculative.
· Projects, tasks, or activities identified in the RMP that are non-essential but important to achieve RMP success within 5 years.
· Contributes to the success of the RMP.
· “Nice to Do’s”:
· Example:  Develop cooperative weed management plans.

Low Priority:  
· Projects, tasks, or activities identified in the RMP that are good ideas, but not crucial to successful RMP implementation within 5 years.
· Generally relates to lesser profile planning issues or geographical/economic/social demands.  
· If there weren’t conflicting workloads, these tasks would be completed.
· Remember: these are low priority over the next 3-5 years.  They might rise to a higher priority with time or additional funding; or they might be dependent on completion of other activities.
· “Could Do’s”
· Example:  Partner with Game and Fish, FWS, and wildlife services on recovery plans.
[bookmark: _Toc342487012]Definition of Magnitude  
Instructions:  After determining whether an activity is high, medium, or low priority, the next step is to determine whether the activity is high, medium, or low magnitude.  You can do this while assigning priorities or after all the priorities are identified.

The magnitude of an activity is based on its anticipated geographic scope, workload, staff time, and cost, relative to the total amount of work that will be done within a certain timeframe (typically a field season or fiscal year).  The magnitude of a project, activity, or task is determined by comparing it to the total workload of one person or one program or the entire planning area.  However your team decides to do it, just be consistent and document your assumptions.

Suggested Participants:  Interdisciplinary team (small groups), field and/or district manager, partners, facilitator.


High Magnitude:
· Projects, tasks, or activities that take relatively considerable time, money, or energy.  
· Costly, time consuming, or difficult.  
· A person, program, or office is only able to work on one or a few high-magnitude projects at a time successfully.
· Example:  major right-of-way.

Moderate Magnitude:
· Projects, tasks, or activities that are neither considerably difficult or easy, costly or cheap, or time-consuming or quick to accomplish.  (In other words, these are the projects that aren’t high magnitude and they’re not low magnitude.)  
· A person, program, or office can handle several medium-magnitude projects at a time successfully.  

Low Magnitude:
· Projects, tasks, or activities that take relatively little time, money, or energy. 
· Takes only a few hours or days, requires little money, is not particularly difficult.  
· A person, program, or office can handle many low-magnitude projects at a time.


Some Other Considerations:  When determining magnitude, be careful to note that although individual tasks may be low magnitude, when combined (as for a larger project), that may bump it up to medium or high magnitude.  

Of course, just because a project, task, or activity is high (or low) priority, it doesn’t automatically mean it’s also high (or low) magnitude, and vice versa.  A couple of examples may help illustrate this point:

Example 1:  you might identify monitoring a certain species population as high priority.  If the habitat of this species is limited to a small, easily accessible area of the planning area, then the workload may only require one employee at a certain time of year, and the monitoring might not cost very much; therefore, it would be low magnitude.  We often refer to high priority / low magnitude tasks, activities, and projects as “low hanging fruit”.  These are the types of projects that a field office would undertake first because they would get “more bang for their buck”.   

Example 2:  you might determine that inventorying the coal potential throughout your planning area is low priority.  And in your planning area, this would be a huge workload that would take lots of staff time and cost a significant amount of money, causing it to be high magnitude.   This is the type of project identified as low priority / high magnitude , and would be among last projects an office might consider doing that fiscal year.

As with priorities, determining whether a project, task, or activity fits into the high, medium, or low magnitude classification can be tricky, and depends on its relationship to all other activities.  Be mindful of the workload implications if you have a lot of high magnitude activities that are also deemed high priority.
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Opening a Workbook
1. Click on the File tab.
2. Select Open in the left pane.
3. Locate and select the file you want to open.
4. Click the Open button.
Opening a Recent Workbook
1. Click on the File tab.
2. Select Recent in the left pane.
3. Select the document in the Recent Workbooks pane.
Saving a Workbook
1. There are 3 ways to save the document as an Excel 2007 or Excel 2010 file:
a. Click on the File tab, then Select Save from the left panel.  OR
b. Click on the Save icon button on the Quick Access Toolbar across the top.  OR
c. Click on Ctrl + S.
2. Select the location where you want to save the workbook.
3. Enter a file name in the File name box.
4. Click the Save button.
Color-Coding a Worksheet Tab
1. Select the worksheet.
2. Click on the Home tab.
3. Click the Format button in the Cells group.
4. Select Tab Color and select a color from the color palette.
Selecting Rows or Columns
1. To select an entire row or column, click the row or column heading (4 or K, for example)
2. To select a range of rows or columns, click and drag the mouse pointer over the row or column headings.
3. To select non-adjacent rows or columns, hold the Ctrl key and click on each row or column heading.
Inserting a Row (or column)
1. Select the row heading below (or column heading to the right) of where you want to insert the row. (to insert multiple rows, select the same number of rows you want to insert)
2. Click on the Home tab.
3. Click the arrow on the Insert Cells button in the Cells group.
4. Select Insert Sheet Rows from the menu.
5. Follow the same process for inserting columns.
Deleting a Row (or column)
1. Select the row heading you want to delete. (to delete multiple rows, select the same number of rows you want to delete)
2. Click on the Home tab.
3. Click the arrow on the Delete Cells button in the Cells group.
4. Select Delete Sheet Rows from the menu.
5. Follow the same process for inserting columns.
Adjusting Row Height or Column Width
1. Select the row(s) or column(s) you want to adjust.
2. Click on the Home tab and do any of the following:
a. To adjust using the mouse: Place the mouse pointer over the boundary line of a row or column heading until it turns into a double-sided arrow.  Click and drag the boundary to adjust it.  OR
b. To adjust to fit cell data:  Click the Format button in the Cells group and select AutoFit Row Height or AutoFit Column Width.  
c. To set a precise height or width: Click the Format button in the Cells group and select Row Height or Column Width.  Enter a value in the box and click the OK button.
Merging Cells
1. Select the cells you want to merge.
2. Click on the Home tab.
3. Click the arrow on the Merge & Center button in the Alignment group and do one of the following:
a. To merge the cells and center the text, select Merge & Center from the resulting menu.
b. To merge without centering, select Merge Across or Merge Cells from the resulting menu.
NOTE:  To split merged cells, select cells, click arrow on Merge & Center button, select Unmerge Cells from resulting menu.
Changing the Workbook View
1. Click on the View tab.
2. In the Workbook Views group, do one of the following:
a. To view the workbook in Normal view, click the Normal View button (this is the default).
b. To view as it will look when printed, click the Page Layout View button.
c. To view and adjust page breaks, click the Page Break Preview button. 
d. To view the workbook in full screen view, click the Toggle Full Screen View button (press Esc key to return to default view.)
NOTE: to quickly change the workbook view, click the Normal, Page Layout, or Page Break Preview button on the Status bar.
Freezing a Row or Column
You can freeze horizontal or vertical panes to keep row and column labels or other data visible as you scroll through the worksheet.
1. Click on the View tab.
2. Do one of the following:
a. To freeze rows, select the row below where you want the split to appear.
b. To freeze columns, select the column to the right of where you want the split to appear.
c. To freeze both rows & columns, select the cell below and to the right of where you want the split to appear.
3. Click the Freeze Panes button in the Window group.
4. Select Freeze Panes from the resulting menu.
5. To unfreeze, click the Freeze Panes button in the Window group and select Unfreeze Panes from the resulting menu.
NOTE:  To freeze the top row or first column, click the Freeze Panes button in the Window group and select Freeze Top Row or Freeze First Column from the resulting menu.
Previewing and Printing a Workbook
1. Click on the File tab.
2. Select Print in the left pane (Print Preview is automatically displayed in the right pane).
3. Select print options in the middle pane.
4. Click the Print button (or Ctrl + P) to print the document.
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	PE Code
	Name (unit of measure)
	
	
	
	
	
	
	

	

	AE
	Heritage Resources Education and Outreach (number of products delivered)

	AJ
	Consultations with Indian Tribes and Alaska Native Corp (number of consultations)

	AK
	Inventory, Repatriate and Transfer Custody of NAGPRA Items (number)

	AL
	Public Outreach Through Interpretation & Enviro Educ (programs/events delivered)

	AM
	Provide Rural Fire and Community Assistance (number of departments receiving benefits)

	AP
	Bureau of Land Management Indian Lands Surveyors Consulting Services (consultations)

	AQ
	Boundary Standard Documents Produced (number of certificates)

	AR
	Intentional Excavation or Inadvertent Discovery of NAGPRA Items

	BA
	Inventory Recreation Resources (acres)
	 
	 
	 
	 

	BB
	Alaska Mineral Land Assessment (number of sites investigated)
	 
	 

	BC
	Acres of Heritage Resource Inventories (Acres)
	 
	 
	 

	BD
	Heritage Collections, Accessioned, Inventoried or Upgraded in non-BLM Facilities (#)

	BE
	Inventory for Wilderness Character (acres)
	 
	 
	 
	 

	BF
	Assess Hazmat Sites (sites)
	 
	 
	 
	 
	 

	BG
	Assess Other Hazards (Non-Hazmat or AML) (number)
	 
	 

	BH
	Inventory Abandoned Mine Land Sites (sites)
	 
	 
	 

	BJ
	Approve Cadastral Surveys (miles)
	 
	 
	 
	 

	BK
	Complete Cadastral Field Miles Survey  (miles)
	 
	 
	 

	BL
	Collect Digital Cadastral Data (GCDB) (number of townships)
	 
	 

	BM
	Update Digital Cadastral Data (GCDB) (number of townships)
	 
	 

	BN
	Inventory Water Resources (number of inventory station parameters)
	 

	BO
	Inventory Soils Resources  (acres mapped)
	 
	 
	 
	 

	BP
	Watersheds Assessed (acres)
	 
	 
	 
	 
	 

	BQ
	Inventory of Ecological Sites (acres completed)
	 
	 
	 

	BR
	Inventory Shrub, Grassland/ PJ Vegetation  (acres)
	 
	 
	 

	BS
	Inventory for Presence Invasive Plants and/or Noxious Weed  (acres)
	 

	BT
	Inventory Forest/Woodland Vegetation  (acres)
	 
	 
	 

	BU
	Inventory Lakes/Wetland Areas  (acres)
	 
	 
	 
	 

	BV
	Inventory Streams/Riparian Areas  (miles)
	 
	 
	 
	 

	BW
	Museum Collections Accessioned, Inventoried or Upgraded in BLM Facilities (number)

	BX
	Manage Public Land Records (number)
	 
	 
	 
	 

	BY
	Inventory Linear Recreation Resources (miles)
	 
	 
	 

	BZ
	Inventory Designated Wild and Scenic Rivers (miles)
	 
	 
	 

	CB
	Inventory Wildlife/Plan Habitat (acres)

	CC
	Assessment or Prediction of Air Resource Conditions (number of actions completed)

	CD
	Assess Ecoregions (acres)

	CE
	Inventory National Scenic and Historic Trails (miles)

	CF
	Inventory Invasive Animal Populations

	CG
	Historic Structures Recorded, Evaluated, and Studied

	DA
	Prepare and Revise Recreation Activity Plans (number)
	 
	 

	DB
	Plan for Commercial Activities  (number)
	 
	 
	 
	 

	DC
	Prepare Wilderness/WSR/NSHT/Cultural/Paleontological Activity Plans (number)

	DD
	Plan for Public Health/Safety and Property Protection (number)
	 
	 

	DF
	Plan for Interdisciplinary Activities  (number)
	 
	 
	 

	DI
	Plan for Herd Management (number)
	 
	 
	 
	 

	DJ
	Evaluate Land Use Plans (number)
	 
	 
	 
	 

	DK
	Plan for Threatened & Endangered Recovery  (number)
	 
	 
	 

	DN
	Prepare Pre-Land Use Plan (number completed)
	 
	 
	 

	DO
	Complete Land Use Plan Scoping Report/Planning Criteria (number completed)

	DP
	Prepare Draft Land Use Plans (number completed)
	 
	 
	 

	DQ
	Prepare Proposed LUP/Final EIS (number completed)
	 
	 
	 

	DR
	Resolve Protest/Prepare Record of Decision (number completed)
	 
	 

	DS
	Prepare Draft EIS Level Land Use Plan Amendment (number completed)
	 

	DT
	Prepare Final LUP Amendment/Record of Decision (number completed)
	 

	DU
	Prepare EA Level LUP Amendment/Record of Decision (number completed)
	 

	DV
	Review Other Bureau Proposed Actions (Reviews Conducted)
	 
	 

	DW
	Plan Pre-Proposal Reserve cost (SNPLMA)
	 
	 
	 
	 

	DX
	Complete RMP Implementation Strategies (number completed)
	 
	 

	EA
	Process SRPs for Commercial Users & Groups (permits administered)
	 

	EB
	Issue & Manage Recreation Use Permits (permits administered)
	 
	 

	EC
	Process Water Rights Actions (number)
	 
	 
	 
	 

	ED
	Transfer Grazing Preferences (number)
	 
	 
	 
	 

	EE
	Issue Grazing Permits/Leases (permits processed)
	 
	 
	 

	EF
	Issue Grazing Bills (number)
	 
	 
	 
	 
	 

	EG
	Prepare Vegetative Permits/Contracts (number)
	 
	 
	 

	EI
	Develop and Issue Federal Fluid Mineral Leases (number)
	 
	 

	EJ
	Process Fluid Minerals APDs (number)
	 
	 
	 
	 

	EK
	Manage Helium (MMcf)
	 
	 
	 
	 
	 

	EL
	Process Coal Leases and Exploration Licenses (actions processed)
	 

	EM
	Process Coal Post Lease Actions (post lease actions processed)
	 
	 

	EN
	Process Non-Energy Mineral Licenses, Permits, or Leases (number processed)

	EO
	Process Non-Energy Mineral Post Lease Actions (number)
	 
	 

	EP
	Process Mineral Material Disposal Through Sales (number of contracts)
	 

	EQ
	Process Leases, Permits, Licenses, and Easements (actions processed)
	 

	ER
	Process Rights-of-Way Grants(number of actions)
	 
	 
	 

	ES
	Process Recreation & Public Purpose Leases (acres leased)
	 
	 

	ET
	Process Withdrawal Actions (acres withdrawn)
	 
	 
	 

	EU
	Process Land Sales (acres disposed of)
	 
	 
	 
	 

	EW
	Record/Adjudicate Mining Claims/Sites (number of claims/sites)
	 
	 

	EX
	Process Mining Plans of Operation (plans processed)
	 
	 
	 

	EY
	Determine Mining Claim Validity/Process/Mineral Patents (number)
	 

	EZ
	Collect Mining Claim/Site Fee (number of claims/sites)
	 
	 
	 

	FB
	Permits Issued Authorizing Heritage Resource Investigations (number)

	FD
	Heritage Resources Intensively Recorded, Evaluated and Studied (number)

	FF
	Process O&G Reservoir Management Agreements (number)

	FH
	Process & Manage SRP's for Non Commercial (number of permits issued/monitored)

	FI
	Process Admin Changes Post Lease Federal Fluid Minerals (actions)

	FJ
	Process Fluid Minerals Sundry Notices (number)

	FK
	Process Indian Pre-Lease Actions for Energy Minerals(number processed)

	FL
	Process Mining Notices (notices processed)

	FM
	Process Land Exchanges (acres disposed in exchange)

	FN
	Support Hydropower Licensing (number of licenses issued)

	FO
	Process Land Exchanges-Acquisitions (acres acquired in exchanges)

	FP
	Process Right-of-Way Actions Other than Grants (actions processed)

	FQ
	Process Withdrawal Revocations and Similar Actions (acres reviewed)

	FR
	Process Land Disposals Other than Sales (acres disposed)

	FS
	Process Indian Pre-Lease Actions for Non-Energy Minerals (actions processed)

	FT
	Process Geophysical Leases/ Permits / Licenses (actions processed)

	FU
	Manage Fee Collection Program for RUPs& SRPs (number of fee sites managed)

	FV
	Administer the Recreation Fee Program (number of fee sites managed)

	FW
	Process Mineral Material Disposals Through Permits (permits issued)

	FX
	Process Renewable Energy (Wind/Solar) Authorizations (actions processed) 

	FY
	Record/Adjudicate Financial Guarantee

	GA
	Cost Recovery - Competitive Coal Lease (actions processed)
	 
	 

	GB
	Cost Recovery - Coal Lease Modification ( number processed)
	 
	 

	GC
	Cost Recovery Coal - LMU Formation or Modif (number of apps processed)
	 

	GD
	Cost Recovery Coal - Royalty Rate Reduction (number processed)
	 

	GE
	Cost Recovery Non-Energy Min - Prospecting Permit Applications (number)
	 

	GF
	Cost Recovery Non-Energy Min – Preference Right Lease Apps (number)
	 

	GH
	Cost Recovery Non-Energy Minerals - Competitive Lease (number processed)
	 

	GI
	Application to Suspend, Waive or Reduce Rental, Minimum Royalty, or Product (number)

	GJ
	Cost Recovery Non-Energy Min - Future or Fractional Interest Lease (number)
	 

	GK
	Cost Recovery Mineral Materials - Noncompetitive Sale (number processed)
	 

	GL
	Cost Recovery Mineral Materials - Competitive Sale (number processed)
	 

	GM
	Cost Recovery Mineral Materials Contract Renewal (number processed)
	 

	GN
	Cost Recovery Mining Law Admin - Plan of Ops with an EIS (plans processed)

	GO
	Cost Rec M L Admin – Validity & Mineral Exams & Reports (number com/app)

	GS
	Administrative Site Condition Assessment (Administrative Sites Assessed)
	 

	GT
	Recreation Site Condition Assessment (Recreation Sites Assessed)
	 

	GU
	Road Condition Assessment (Lane Miles Assessed)
	 
	 
	 

	GW
	Dam Condition Assessment (Dams Assessed)
	 
	 
	 

	GX
	Bridge Condition Assessment (Bridges Assessed)
	 
	 
	 

	GY
	Trail Condition Assessment (Miles Assessed)
	 
	 
	 

	HD
	Manage Forest and Woodland Commercial Sales (acres)
	 
	 

	HE
	Biomass Utilization (tons)
	 
	 
	 
	 
	 

	HF
	Heritage Resources Stabilized, Managed and Protected (number)
	 
	 

	HG
	Adopt Wild Horses and Burros  (number of animals)
	 
	 
	 

	HH
	Long Term Hold WH&B (number of animal days)
	 
	 
	 

	HI
	Prepare/Hold Wild Horses and Burros  (number of animal days)
	 
	 

	HL
	Apply Commercial Forest and Woodland Management (acres)
	 
	 

	HM
	Process Alaska Native Allotment Conveyances (parcels patented)
	 
	 

	HN
	Process Land Purchase/Donation (number of acres purchased or donated)
	 

	HO
	Respond to Hazmat Risk Site (actions)
	 
	 
	 
	 

	HP
	Remediate AML Physical Safety Hazards (number of sites)
	 
	 

	HQ
	Mitigate Other Hazards  (number)
	 
	 
	 
	 

	HT
	Ensure Fire Preparedness (number of admin units passing review)
	 
	 

	HU
	Manage Wildland Fire (acres burned)
	 
	 
	 
	 

	HX
	Patent Alaska State Conveyances  (acres patented)
	 
	 
	 

	HY
	Patent Alaska Native Corp Conveyances  (acres)
	 
	 
	 

	IA
	Recreation Site Building Annual Maintenance (Number of Buildings Maintained)

	IB
	Facilities Deferred Maintenance and Construction (Number of Projects)

	ID
	Trail Annual Maintenance (Miles Maintained)

	IE
	Trail Deferred Maintenance and Construction (Number of Projects)

	IG
	Bridge Annual Maintenance (Bridges Maintained)

	IH
	Bridge Deferred Maintenance and Construction (Number of Projects)

	IJ
	Dam Annual Maintenance (Dams Maintained)

	IK
	Dam Deferred Maintenance and Construction (Number of Projects)

	IM
	Administrative Site Building Annual Maintenance (Number of Buildings Maintained)

	IN
	DELETED Admin Site Deferred Maintenance and Construction (Number of Projects)

	IP
	Road Annual Maintenance (Lane Miles Maintained)

	IQ
	Road Deferred Maintenance and Construction (Number of Projects)

	IU
	Recreation Site Non-Building Annual Maintenance (Number of Sites)

	IY
	Administrative Site Non-Building Annual Maintenance (Number of Sites Maintained)

	JA
	Apply Shrub/Grass Vegetation Treatments (acres)
	 
	 
	 

	JB
	Construct Shrub/Grass/PJ/Forest Projects (number)
	 
	 
	 

	JC
	Maintain Shrub/Grass/PJ/Forest Projects (number)
	 
	 
	 

	JD
	Apply Weed Treatments  (acres)
	 
	 
	 
	 

	JE
	Restore Forest and Woodland Through Sales (acres)
	 
	 
	 

	JF
	Apply Lake/Wetland Treatments (acres)
	 
	 
	 
	 

	JG
	Apply Stream/Riparian Treatments (miles)
	 
	 
	 
	 

	JH
	Construct Lake/Wetland/Stream/Riparian Projects (number of projects)
	 

	JI
	Maintain Lake/Wetland/Stream/Riparian Projects (projects maintained)
	 

	JJ
	Gather/Remove Wild Horses and Burros (number of animals removed)
	 

	JK
	Implement AML Projects to Restore Water Quality (acres)
	 
	 

	JL
	Apply Fire Rehab Treatments (acres)
	 
	 
	 
	 

	JM
	Implement Fuels Treatments Outside WUI Using Prescribed fire (acres treated)

	JN
	Restore Forest and Woodlands through Development (acres)
	 
	 

	JP
	Implement Threatened and Endangered Species Recovery Actions (number)
	 

	JQ
	Implement Fuels Treatment Mechanically outside of WUI (acres treated)
	 

	JR
	Implement Fuels Treatment by other means outside of WUI (acres treated)
	 

	JS
	Stabilize Burned Areas (acres stabilized)
	 
	 
	 
	 

	JT
	Reduce Fuels Mechanically within WUI (acres treated)
	 
	 
	 

	JU
	Reduce Hazardous Fuels by other means within WUI (acres treated)
	 

	JW
	Implement Fuels Treatments by prescribed fire Within the WUI (acres treated)

	JX
	Decommission and Rehabilitate Roads and Trails (miles)
	 
	 

	JZ
	Native Plant Materials Collection (number of collections)
	 
	 

	KA
	Process Alaska Nat Allotment Selections (parcels approved, processed unapproved)

	KB
	Convey Alaska State Selections (acres conveyed by tentative approval) )

	KC
	Convey Alaska Native Corporation Selections (acres conveyed by interim con)

	KD
	Process Land Sales, Purchase/Donation (Cases procd, lands not sold or acq)

	KE
	Implement Conservation Actions for Non-ESA Species and Communities

	KF
	Gather/Treat Wild Horses and Burros

	KG
	Wild Horse and Burro Population Growth Suppression

	KH
	Prepare and Conduct Competitive Renewable Energy (Wind/Solar) Actions

	KI
	Process Renewable Energy (Wind/Solar) Actions Other than Authorizations

	KO
	Historic Structures Protected, Stabilized, or Restored

	KP
	Number of Title and Boundary Conflicts Resolved

	LA
	Monitor Designated National Scenic and Historic Trails (miles)

	LB
	Monitor and Maintain AML Physical Safety Closures

	LC
	Monitor Fuels Treatment in Wildland Urban Interface

	LD
	Historic Structures Monitored

	MA
	Monitor Recreation Areas (acres)
	 
	 
	 
	 

	MB
	Evaluate Forest/Woodland Treatments  (acres)
	 
	 
	 

	MC
	Conduct Census WH&B Areas (number)
	 
	 
	 
	 

	MD
	Monitor Wilderness and Wilderness Study Areas (acres)
	 
	 

	MF
	Monitor Designated Wild and Scenic Rivers (miles)
	 
	 
	 

	MG
	Monitor and Maintain AML, HAZMAT and NRDAR Sites  (number of sites)
	 

	MI
	Monitor Air Quality and Climatic Conditions  (number of parameters collected)
	 

	MJ
	Evaluate Land Health  (evaluation reports)
	 
	 
	 
	 

	MK
	Evaluate Weed Treatments (acres)
	 
	 
	 
	 

	ML
	Monitor Grazing Allotments (number)
	 
	 
	 
	 

	MN
	Monitor Lake/Wetland Habitat  (acres evaluated)
	 
	 
	 

	MO
	Monitor Streams/Riparian Habitat  (miles)
	 
	 
	 
	 

	MP
	Monitor WH&B Herd Management Areas  (number)
	 
	 
	 

	MQ
	Monitor Terrestrial Habitat (acres)
	 
	 
	 
	 

	MR
	Monitor Species Populations  (number)
	 
	 
	 
	 

	MT
	Monitor Fuels Treatment  (acres)
	 
	 
	 
	 

	MU
	Monitor Water Resources  (number of monitoring station parameters)
	 

	MV
	Monitor Linear Recreation Management Objectives (miles)
	 
	 

	MW
	Conduct Fluid Mineral Surface and Environmental Monitoring (sites monitored)

	MX
	Monitor Shrub/Grass Vegetation Treatments (acres)
	 
	 
	 

	MY
	Heritage Resources Monitored  (number)
	 
	 
	 
	 

	MZ
	Monitor Post Fire Emergency Stabilization and Rehabilitation Treatments (acres)

	NA
	Inspect Allotments for Grazing Authorization Compliance (number)
	 
	 

	NB
	Conduct Fluid Mineral Inspection & Enforcement (# of inspections completed)
	 

	NC
	Resolve Fluid Mineral Drainage Cases (number)
	 
	 
	 

	NF
	Inspect, and Verify Production at Mineral Material Site (number)
	 
	 

	NG
	Inspect Coal Operations and Verify Production (number)
	 
	 

	NH
	Conduct Realty Compliance Inspections (number)
	 
	 
	 

	NI
	Inspect Locatable Mineral Sites for Surface Mgt Compliance (# of inspections)
	 

	NJ
	Process Trespass/Unauthorized Occupancy Cases (# of cases processed)
	 

	NK
	Conduct WH&B Compliance Inspections (number of animals)
	 
	 

	NP
	Evaluate PRPs for Cost Avoidance/Recovery (number)
	 
	 
	 

	NQ
	Process HAZMAT Cost Avoidance/Recovery Cases (number)
	 
	 

	NU
	Conduct Patrol Enforcement Activities (number of incidents reported)
	 

	NV
	Conduct Investigative Activities (incidents closed)
	 
	 
	 

	NY
	Conduct Emergency Response Activities (number of incidents resolved)
	 

	NZ
	Conduct Security Activities (number of vulnerability assessments)
	 
	 

	OA
	Conduct Drug Enforcement Activities (number of seizure incidents)

	OB
	Inspect & Verify Production at Solid Leasable Mineral Sites-Non Energy (#)

	OC
	Conduct Inspections on Geophysical Exploration Authorized by NOI (#)

	OD
	Conduct Renewable Energy (Wind/Solar) Compliance (compliance actions)

	OE
	Subsurface Mineral Trespass

	PC
	Provide Program Support; Natural/Cultural Heritage(none)
	 
	 

	PH
	Provide Program Support: Restore Health of Public Lands (none)
	 
	 

	PI
	Provide Program Support: Sustaining Biological Communities (none)
	 

	PJ
	Provide Program Support: Forest Products (none)
	 
	 
	 

	PK
	Provide Program Support: Forage (none)
	 
	 
	 
	 

	PM
	Provide Program Support: Quality Recreational Experience (none)
	 
	 

	PN
	Provide Program Support: Protection of Lives, Resources, and Property (none)

	PO
	Public Resources - Non-Energy (none)
	 
	 
	 
	 

	PP
	Provide Program Support: Public Resources -  Energy (none)
	 
	 

	PQ
	Provide Program Support: Renewable Energy (none)
	 
	 
	 

	RA
	Revenue Billings and Collections (none) 
	
	
	
	

	RB
	National Gas Royalties and Sales (none)
	
	
	
	

	RD
	Payroll Deduction - Meals (none)
	
	
	
	

	RH
	Revenue Billings and Collections (none) 
	
	
	
	

	XA
	Plan and Develop IT Systems (none)
	 
	 
	 
	 

	XB
	Provide IT Hardware/Software Installation,Upgrade, and Training (none)
	 

	XC
	Implement and Maintain Communication Networks (none)
	 
	 

	XD
	Provide IT Operations and Maintenance (none)
	 
	 
	 

	XE
	Provide Data Administration (none)
	 
	 
	 
	 

	XF
	Ensure IT Security (none)
	 
	 
	 
	 
	 

	XG
	Provide Facilities and Space Management Services (none)
	 
	 

	XH
	Manage Records/Central Files/Mailroom/Library/Directives Operations (none)
	 

	XI
	Process Payments, Billings and Collections (none)
	 
	 
	 

	XJ
	Maintain Agency Financial System and Reporting Requirements (none)
	 

	XK
	Manage Procurement, Acquisition and Agreement Activities (none)
	 

	XL
	Provide Personnel Services (none)
	 
	 
	 
	 

	XM
	Provide Employee Development and Training Services (none)
	 
	 

	XN
	Administer Internal Civil Rights (none)
	 
	 
	 
	 

	XO
	Provide Safety Program Services (none)
	 
	 
	 
	 

	XP
	Conduct Management Analysis and Studies (none)
	 
	 
	 

	XQ
	Administer External Civil Rights (none)
	 
	 
	 
	 

	XR
	Provide IT Support (none)
	 
	 
	 
	 
	 

	XS
	Prepare Financial Management Reports (none)
	 
	 
	 

	XT
	Administer Employee and Labor Relations (none)
	 
	 
	 

	XV
	Manage and Support Radio Communications Program (none)
	 
	 

	XW
	Conduct Budget Formulation/Execution and Cost Management Activities (none)

	XX
	Provide Strategic Leadership (none)
	 
	 
	 
	 

	XZ
	Provide Personal Property, Vehicle Fleet Mgt Services & Other Mgt Support Services (none)

	
	 
	
	
	
	
	
	
	


5. 

[bookmark: _Toc342487015]Next Steps
After you have completed Step 2:
1. Review the spreadsheet to be sure Columns 6 and 7 are filled in for every row (project, task, management action).

2. Make sure the decision-maker (typically the field manager or district manager) has reviewed and approved the priorities identified in Column 6.  (It is less important that they review and approve all entries of magnitude.)

3. Determine your strategy for completion of Step 3—are you going to begin it as soon as Step 2 is done or will you wait to time it with your budget process.  Step 3 can be done immediately following Step 2 without State Office approval; however, be sure all necessary parties can participate—this includes the entire interdisciplinary team, key partners and cooperating agencies, manager, budget staff, state (BLM) program leads, and a facilitator.

4. Schedule the time and place to complete Step 3.  

5. Start watching Module 3 of the Plan Implementation Strategy training.



[bookmark: _Toc342487016]Acronyms Used in Plan Implementation Training 

	ACEC
	Area of Critical Environmental Concern

	APD
	Application for Permit to Drill

	ARRA
	American Recovery and Reinvestment Act of 2009

	AWP
	Annual Work Plan

	BLM
	Bureau of Land Management

	BPS
	Budget Planning System

	DO
	District Office (BLM)

	DOI
	Department of the Interior

	ERMA
	Extended Resource Management Area

	FO
	Field Office (BLM)

	FRCC
	Fire Regime Condition Class

	FY
	Fiscal Year

	ID Team
	Interdisciplinary Team

	KRC
	Knowledge Resource Center

	LUP
	Land Use Plan

	NCA
	National Conservation Area

	NLCS
	National Landscape Conservation System

	NTC
	National Training Center

	OHV
	Off-Highway Vehicle

	P&EC
	Planning and Environmental Coordinator

	PE Code
	Project Element Code

	PTA
	Project Target Allocation

	R&PP
	Recreation & Public Purposes

	RMP
	Resource Management Plan

	ROD
	Record of Decision

	ROW
	Right of Way

	SO
	State Office (BLM)

	SRMA
	Special Recreation Management Area

	SRP
	Special Recreation Permit

	WO
	Washington Office (BLM)

	WSA
	Wilderness Study Area

	WUI
	Wildland Urban Interface






[bookmark: _Toc342487017]Example Excel Spreadsheet 

Click the first link to go to a filled out example Plan Implementation spreadsheet, which was developed from actual BLM plans.  You can use it for ideas if you get stuck. 

Link to EXAMPLE Excel Spreadsheet.


Click on the second link to get a copy of a blank Excel spreadsheet.   This is what you should have used when you started populating the columns for Step 1.  Although you should start with the spreadsheet that already has the Step 1 columns filled in (Columns 3, 4, and 5), we are including it just in case you need a blank one.  And remember, be sure to save early and often!

Link to BLANK Excel Spreadsheet
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